Welcome to the Webinar
Migrating from GroupWise 6.5
to Outlook 2002

»Press MUTE or *6 to mute your telephone.
»Please don’t put your phone on HOLD.

»In the ‘chat’ box please enter and send us
your name, division (i.e. Labor Exchange, Field
Services, etc.) email address, and the names of
everyone participating at your location.

» Thanks!! We’ll get started soon!



Department of Labor & Economic Growth

Migrating from GroupWise 6.5 to Outlook 2002

Configuration Information
And
Beginner’s Guide to Using Outlook
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Topics for Today

What Outlook looks
like

How to change the
view

Shortcuts

Inbox: what’s there
Email Options

Sending messages

Distribution Lists:
creating and sharing

New Message Tool
bar

Creating a signature
Using your calendar
Out of Office assistant
Outlook on the web



& Inbox - Microsoft Outlook - |2

Fle Edit View Favorites Tools Actions Hel wtion lis
F' . Outlook Default Screen.

Eaﬂew - S [Pj X GyReply fRyRenly to Al 46 Forward %SEHd;‘REEEi'u'E %Fi_nd %E

Outlook Shorteuts | | 4| 0 % {8 From | Subject \Received T Size '

& (1 Bilig, Joseph Fwd: NWLE Orient - WFT 2008-04-29.ppt Wed 4/23/2008 11:31 ..

&y Gamin, Patty {DLEG) RE: email to all of BWT Fri4/18/2008 23PM  110KEB
2 @ King, Cynthia (DLEG) FW: email to all of BWT Fri 4/18/2008 2:21PM  123KB
2 0 Strevel, Christing Invitations Culook Fri 4/11/2008 Z:57PM B3 KB
=) @ LEWIS, JOHNNIE YWebinar Announcement - Group Wise Conversion to Cutlook 2002 Fri4/11/2008 :16PM  52KB
%y @ Kryza, Richard Selfridge and Lansing TAPS Tue 4/3/2003 10:21 AM 116 KB
9y @ Hubsky, Darlene (D... outlook files Tue 4/3/2003 ::434M  1MB
i<y @ Crow, Loretta Letterhead, Mema, & Fax Templates wMew Bureal Name Tue 4/3/2008 T:56 AM 246 KB
2y @ Morado, Irene Bureau of Warkforce Transformation Information Mon 4/7/2008 2:24PM  27KB
2y @ Strevel, Christina M1 Migration Tranacripts Mon 3/31/2008 2:32PM 83 KB
% 0 Strevel, Christing MIR.54 Hospitality Promising Practices VWebinar Fri 3/258/2008 10:59 &AM 54KB
2 @ Kryza, Richard TAPS Thu 3/27/2008 2:02PM 9B KE
iy @ Billig, Joseph Michigan1 - information documents Wed 3/19/2008 8:12 AM 1MB

T |ﬂ Extra line breaks in this message were remaoved. To restore, dick here,
From: Bilig, Joseph To:  Pafford, Jamie; Hubsky, Darlens (DLEG)

Subject: Fad: NVLE Orient - WFT 2008-04-29,ppt e

Attachments: &|1evT him (535 8): EF]NWLE Grient - WFT 2008-04-2,pot (551KE)

153 |

Per Chris's request. Thanks for looking at this.

Joe
DeletedTtems | |>>> Joseph Billig 4/21/2008 6:14 PM >
(8) lchrias,




Folders list has been added.

Outlook Shortcuts

G

Qutlook Today

Tasks

MNotes

Celsted Items
(8)

My Shortouts

Other Shortcuts

Folder List X

EI--@ Outlook Today - [Mailbox - Hube

----- i Cabinet

----- % Calendar

----- B Checklist

----- @ Common Measures
----- '@ Contacts

----- (# Deleted Items (&)
----- @ Documents

----- B Drafts

----- @ Field Services Group Addre:

+-73 Inbox

{ﬁ Journal

----- B Junk E-mail

----- B Junk E-mail1

----- 1 leadership academy
----- @ ranagment institute

@ Outhox

----- B Webinar flles

+- 3 Public Folders

1 2|

H
+

T

ERDEBEREERRDEBDEREBEEREDEDD

D|‘?|Q|Frnm

Dan Mulhern

Gamin, Patty ...
d King, Cynthia ...
0 strevel, Christ,,,

Lehman, Kerry...

Strevel, Christ,..
@ Strevel, Christ,.,

{ LEWIS, JOHNNIE Webinar Announcement - Group Wise Conversion to Cutlook 2002

0 Kryza, Richard
(0 Hubsky, Darle, ..
0 Crow, Loretta
{i Morado, Irene
0 Strevel, Christ,.
0 Strevel, Christ,.,
0 Eilig, Joseph
@ Billg, Joseph
0 Kryza, Richard
lehmank@Exc. ..
{i Bilig, Joseph

| Subject

Your Responses Last Week Were Like Dynamite
RE: email to all of BWT
Fu/: email to all of BWT
Re: about that emal
RE: BWT site

Re: about that emal

Invitations Culook

Selfridge and Lansing TAPS
outlook files

Letterhead, Memo, & Fax Templates w/Mew Bureau Mame
Bureau of Workforce Transformation Information

M1 Migration Transcripts

MiRSA Hospitality Promising Practices VWebinar

Re: Making Email Groups in Outlook
Re: Making Email Groups in Qutlook
TAPS

BWP Training page

Michigan1 - information documents

| Received

Mon 4/21/2008 7...
Fri 4/18/2008 4:2...
Fri 4/18/2008 2:2...
Tue 4/15/2008 1..,
Tue 4/15/2008 1...
Tue 4/15/2008 1...
Fri 4/11/2008 2:5...
Fri 4/11/2008 1:1...
Tue 4/8/2008 10:..,
Tue 4/3/2008 3:4...
Tue 4/8/2008 7:5...
Mon 4/7/2008 2.,
Man 3/31/2008 2...
Fri 3/28/2008 10:...
Fri 3/28/2008 2:0...
Fri 3/28/2008 3:4...
Thu 3/27/2008 2:...
Thu 3/27/2008 9:...
Wed 3/19/2008 &...

703 B
1 MB




Outlook Shortcuts and what they mean...

Outook Shaortouts

Cutook Today

Inbox

Calendar

Contacts

Motes

R
+

-l

Deleted Items
(3)

Outlook Today -

provides a summary of the Appointments,
Tasks, and how many messages are waiting in
the Inbox.

Inbox - contains all of the incoming messages
(email, appointments, etc.)

Calendar - displays all Appointments and
Tasks.

Contacts - allows the user to access the global
exchange address book and allows for the
entry of new personal address contact
information.

Tasks - displays the tasks in chronological
order.

Notes - personal notes as reminders.

Deleted Items — storage for messages deleted
from Outlook. This allows the user one last
chance to recover items.



Outlook Today

<5 Back ) outlook: today

Outlook Shortouts Munday, April 21, 2008

@ Calendar Tasks

Qutlook Today

Today
» Hald for Saginaw
Tuesday
Inbox all 2z event This one is at AMG in Lansing, not at Selfridge
TAP classes (Selfridges AMNG)
TAP training (Selfridge ANG)
Calendar Wednesday
Py M/ 1 Migration Pilot/Cadillac Place (Cadillac Place)
ﬁ' Outlook Dry-Run {From your Desk)
Contacts Thursday
M/ 1 Migration Cadillac Place Pilot {Cadillac Place Detroit)

annual leave

Deleted Items

ey
o)

My Shortcuts

Other Shortcuts

To Activate Outlook Today
Click on View, Go To, Outlook Today,
or click on the shortcut on the Outlook Shortcut bar.

Customize Outlook Today ...

Messages
Inbosx 0
Drafts o
Qutbox u]



{1 Back wH outiook:today [ Go

L E T Customize Outlook Today

@ Startup W When starting, go directly to Outiook Today
Qutlook Today
fA Messages Show me these folders:  Choose Falders. .. |
B
Inbox
Calendar Show this number of days in my calendar |5 =

Tasks In my task list, show me: & Al tasks
(" Today's tasks
¥ Include tasks with no due date

¢ E—
i Sort my task list by: [Due Date x| thenby: |{nane) -
Contacts (" Ascending (= Ascending
fv Descending (¢ Descending
Tasks Styles Show Outlook Today in this style:  [RfelyeEl v
Motes

Deleted Items

My Shaortruts

Other Shortouts



Any Questions? Type them In
chat please!!



Inbox

SRR lT

Outiook Sharteuts | | 01| % | @) Fram |subject Received T Size [
I Dan Mulhern Your Responses Last Week Were Like Dynamite Mon 4/21/2008 7:42 AM  13KB
(@ i Gamin, Patty (DLEG) RE: email to all of BWT Fri 4/18/2008 23PM  110KB
3] 0 King, Cynthia (DLEG) FW: email to all of BWT Fri 4/18/2008 2:21PM  123KB
OutiookToday | ¢  § Strevel, Christina Re: about that email Tue 4/15/2008 10:55AM 229 KB
f"" ) Lehman, Kerry (DIT)  RE: BWT site Tue 4/15/2008 10:43 &AM 5KB
;H_“ ) Strevel, Christing Re: about that email Tue 4/15/2008 10:25 &M 1KB
Inbox 2y @ Strevel, Christing Invitations Oulook Fri4/11/2008 2:57FM  B3KB
2y @ LEWIS, JOHNNIE Webinar Announcement - Group Wise Conversion to Cutlook 2002 Fri 4/11/2008 1:16 PM 52KB
2y 0 Kryza, Richard Selfridge and Lansing TAPS Tue 4/3/2008 10:21 AM  115KB
2y 0 Hubsky, Darlene (D.., outlook files Tue 4/3/2008 9:43 aM 1 MB
Calendar 5y @ Crow, Loretta Letterhead, Memo, & Fax Templates w/New Bureau Name Tue 4/3/2008 7:56 AM 246 KB
2y @ Morado, Irene Bureau of Workforce Transformation Information Mon 4/7/2008 2:24PM 27KB
"' 2y @ Strevel, Christing M1 Migration Transcripts Mon 3/31/2008 2:32PM  8RKE
o 2y @ Strevel, Christing M54 Hospitality Promising Practices YWebinar Fri 3/28/2008 10:59 &M 54KE
Contacts i2y @ Bilig, Joseph Re: Making Email Groups in Outlook Fri3/28/2008 2:07AM B KB
e iZy 0 Bilig, Joseph Re: Making Email Groups in Qutlook Fri 3/25/2008 8:46 AM  BKB
2y @ Kryza, Richard TAPS Thu 3/27/2008 202PM  98KB
By lehmank@Fxchange... BWP Training page Thu 3/27/2008 9:12AM 703 B
s 2y 0O Bilig, Joseph Michigan/1 - information documents Wed 3/19/2008 3:12 AM 1 MB

©




File Edit View Favorites Tools Actions Help Type

Hinew | & G5 X | Goreoly Sireply o al ¢ Forward | 55 Send/Receive | B Find 3 s
EFES s o Organize Inbox

L0

=

® Move message selected below to [[TRRTR R A - | vove |

[P_-T IJsing Folders

Outlook Today
® Create a rule to move new messages |1'anr| ;I lUnited States Depa into Iwnrking files ;I Create |
To view or edit your rules, and for more advanced option Rules Wizard' above

2

& Inbox - Microsoft Outlook

- FEile Edit View Favorites Tools Actions Help T
- ENew ~ | & B W | Gorenly Sireply oAl GO Forusrd | [ sendReceive | B Find Type & contact to fin

Cutlook Shortouts

o ® Color messages |from = | |Strevel, Christing in |[Fucheiz _~|  Apply Color | Done! /
'
Outlook Today ' Using Folders
; o Messages sent only to me now appear Blus,  Turn off |
f’ﬂ @ IUsing Colors
;M To view or edit y oring, and for more advanced options, dick on Autornatic Formatting” above
Inbox (1)

Use Organize Icon or Go to Tools>Organize



Options within open emaills:

¥ Your Responses Last Week Were Like Dynamite - Message (HTML)

File Edit View Insert Format Tools Actions  Help

CoReply  RyReply to Al W Forward S L [h'j PR ﬁ @ . & Snaglt|[*]' Region -,

Fram:  Dan Mulhern [readingforleading @danmulhern. com] Sent: Mon 4/21/2008 7:41 AM
Tou Hubsky, Darlene (DLEG)

Cc |

Subject: Your Responses Last Week Were Like Dynamite

T

}"

5
R
&

April 21st, 2008 A weekly stimulant for those who lead - From Dan Mulhern

Click here for Dan Mulhern Elog

Danigl Granhalm Mulhzrn Visit danmulhern.com

mulhern@danmulhern.com First Gentleman's website
You can hear the audie versien of

the filz by clicking on the link Your RES[]IDFISES Last Week Were
below Like Dynamite

1)

Blmmms mhm el Sle i e

Friends,



Creating and Sending Email Messages

File Edit View Favorites  Tools

5 Mew ~r| Sp [ XK GeReply !
Mail Message Chrl+H
%.] Postin This Folder Chribadift+5

1 Falder... Ctrl+Shift+E
Ouklook, Bar Shorkout, ..

Td]  Appointment Chrl+Shift+4

.ﬁl LI ] [ - 1 = . =1 1 . -

Film Edit %Yiew Insart Format Took Achions Help
Hend @ & E 0 Be ! 4 v Jogos. (I,

To,. ||

e ||

Subject: |




During Migration...

“*If you send an email to someone and it
comes back undeliverable, it could be that
they have been migrated to Outlook and
your system tried to send them to their
GroupWise address. They look the same
but act differently. IF this happens, go to
the address book, find their name again

from the list, and use it from there.
should fix the problem.

his



New Message Tool Bar

#%end Bl & & [ A %,

e Send

e Save

e Print

e Cut, Copy, Paste
* Insert signature
o Attach file

e Address book

e Check Names

b 4 ¥ tiogtors., & [7)

Importance
— High or Low

Flag

Options

— Importance,

— Voting and tracking
— Delivery Options
Font Size

Outlook Help



Creating Distribution Lists

e New>Distribution Lists>Select Members

alo ambe
Show Mames from the:

Type Mame or Select from List:

|GI|:|I:|aI Address List

Add to distribution list:

Mame

Members -=

“ 11 1038, Mailbox

& 15370CensusGroup

& 15370DATA

& 2007PRC, DR

& 2 1stCentury
4CoLD, 505 Help
40MI, 505 Help

& SEsAs
R ———
<] >
Mew... Properties |
Ok |

Find...

| Send Options...

Cancel

Help |




Mail groups from GroupWise may
already be saved in your Outlook

Check your Contacts folder for mail groups
that you used in GroupWise.

Look elsewhere In the Folders list for mall
groups that other had shared with you.

New contact groups that you create will be
listed under the Contacts item in Folders.



Sharing Contacts — Step One
Give Permission to view Contacts

Bl =y event approved by Chr
Lo
Right > & 2 annual leave
click on | (= Open
this Contacts . :
Cpen in Mew Window pncert MTL
o Advanced Find...
Remove from Qutlook Bar
Rename Shortout
Motes F'I'I:Il:IEI'ﬁ_ES _




Choose Permission

Tab

Add to find name

REVIEWER is read
only permission

Finally, click on APPLY

Contacts Properties

General ] Home Page ] Cutlook Address Book ] Activities ]
Administration ] Form Permissions Synchronization ]

Permission Level:

Anonymous MNone

Remove

Default Mone

Permissions

Permission Level:

Create items

Read items

Edit items
{* Maone
{" Own
Al

OK

Mare

| Folder owner

-

| Create subfolders | Folder visible

Delete items
{* Mone
" COwn
(" Al

Cancel

Help




Sharing Contacts —Step Two
For those who received permission:

& Outlook Today - Microsoft Outlook

Close All Items
Folder 3

Import and Export...

Print... Ctrl+P
Work Offline

Exit

L

File | Edit View Favorites Tools Actions Help
Mew b hive _%QFi_nu:I
Open b Other User's Folder...

Cutlook Data File...
Wednesday, April 23

M1 Migration Pilot/Cadillac Pla

1 I'narsda

4




Shared Contacts, Step Three:
Saving them to your Contact Llist.

| Open Other User's Folder

Hubsky, Darlene (DLEG) ‘ Ok \

Contacts Cancel ‘

Click OK. Double click the desired list. Click on
FILE>COPY TO FOLDER>Select CONTACTS
>click OK.



Any Questions? Type them In
chat please!!



Tools>Options>Mail

Creating a Signature Format>Signature Section

& Inbox - Microsoft Outlook

File Edit View Favorites Tools Actions Help

Siten + & Y X BoReply €FReply to Al 46 Forward gﬁﬁend;ﬁeg&ive ZFind g

1

i : i N
Signakure Creakte Signature

Automatically include your signature or attach an electronic business Signature:
card (wCard) to outgoing messages,

Signature For new messages:

Signature for replies and Forwards: |<N.;..-.E;=. j

. Mew, ..
— Signatures. .. |
Ik I Cancel | apply |

Preview:

IUnable ko preview selected signature, or no signature selected.

K, I Cancel




Create New Signature ed by

2y

1. Enter a name for your new signakure:

| Inkitled

2, Choose how o create your signature:
¥ Skart with a blank signature

£ Use this existing signature as a template:

i

™ Use this file as a template:

Erowse, .,

Edit Signature - [Signature1]

Signature text
% This text will be included in outgoing mail messages:

Mext = Zancel

Darlene F. Hubsky 5
Human Fesource Developer

DLEG - BWT

614 Johnson

Saginaw, MI 48607 v

Font... | Paragraph... Clear Advanced Edit...

vCard options

V= Attach this business card (vCard) to this signature:

u= <Mone = j

Mew vCard from Contact...

K | Cancel |




Using Your Calendar

[T]0ay 5] Work ek [T eek 57 ont

e Calendar . w4 2 | dovn

Marelay, July 24 "

EI‘I‘I
<
10
11"
ﬂF’"

(o I |

L iuummtmm ]

]

=l

5 My 2006 August: 2006

T HTWTFS IHTWTEPFS
{ t2 3948

345678 &7 8 %101t 42

GIDLLIZI3405 LI MISI6IT B 19

16 [F IB 19 2021 2F DI R AMEN

H [(Emrmxn IHNON

0 H i

D) A Taskpad

| eich be 1

)| Test |




Creating a Personal Appointment

¢ Calendar . november 02 | Address [JTINMEeTNE
Friday, November 02 .| 4 November 2007 »
SMTWTFS
gam 28293031 1 3
- 4567 8 910
o 111213141516 17

10 oo W ¥ JET Data (MDCD Victor 4thFl Conf Rm 1)

- 181920 21 22 25 24

11 | 252627282930
23 456 78
12°Fm
O TaskPad ;l
oo B type your appointment information directly on the calendar... Click here to add a new Task
- [C] |Electronic Delivery of Service...
oa [ | Stack Printing
- []|Mew Proposal for Ticket Han. ..
00 []|Fwd: AWARE 'bad news' letters
N []|rsa 113
oo




1 Plew - %E'

Mail Message

. ] Postin |his Folder
B

Creating an Appointment:

Alternate method
Sppoinktmenk

Meeting Reguer“\}

B Untitled - Meeling
Fle Edt View [Irsert Format  Tools  Ackions Halo
HAsend & A 0. O Recurence... (R Concsiinviation... 1 3 XK ),

Apportment | Schaduing |
0 [t ations have not besn sent For this mesting.

Subfet: |

| | ...... ;] R B st _j
;ﬁtatum; (wWed 7/26/2006 w||o00am  w| [T Allday event
Ga 2

" Endbpe:  |Wed 7/26/2006 R BEETTIE

(4 W geninder: (15 mnutes - ﬂi Show time as: |l Busy x| Labek: [ none =]

contacts,




Scheduling Meetings

. ‘ % dﬂ: E &M I ﬁ- Remedy Traimmg (Femedy Trainmg R-:mﬁ
Mew - :.| SEn

CTE] Mew Appontment
1 Mail Message g oo =5 Hew
Mieis Al Day Event
%] Postin This Folder # L @7 Mew Mesting Reguest |

= New Recuring Appointment

llII
- _ B Recuring Eyent
j Appointment .

me _ Mew Reguring Mesbng
@J Meeting Reguest Today

1tll:l

Go bo Date,
Zm ' Other Settngs. ..

Customipe Current View, .,

3'1' Automatic Sormatting. ..




Scheduling Meeting Details

B Untitled - Meeting

File Edt Yiew [nsart
Hzend & # A 0, < Recurence,.. T Cancel Invitation. ..

Appontment | Scheduing |
0} Invvitations have not besn sent for this mesting.

Format Tools  Actions  Halo

' 3 X 0.

Bx

To,.. | |

Subject: |

Location: |

ﬁtat tine;

= End tane:

=T

Select Attendees and Hesources

X

Contacts, ,, | |

Show Names from the: Ilﬂobal Address List
i'nHedE 7126f j |g;£|:| ok Tvpe Mame or Select from List:
\Wed 7/26/2006 | |9:30 AM [warren, R
q | Mame Reguired -» Lewids, David;
}-l v Reminder: {15 minutes j .;E}'.i Show time 89 [ B ware, Aided = Eﬂ:ﬂ. Steve !
6 Warren, Rick
© 'Warren, Robert .
Warren, Fon (DIT) Optional ->
B Warren, Ronry
& Warren, Tamara
i Warren, Tom R
i Warren, Vernece o PAANERS S |
r ini CERE 1 " }
New,. | Properties | Find. .. ] Sand Options, .
I K | Cancel | Help |




Doing a BUSY SEARCH , called SCHEDULING

BE Blackberry Training - Mealing E”EFE
Ble Edt Vew [nsart Format Tooks Actions  Halbp ;
Asend & [ B0, O Recyrence... B Concellpvitation... ' § X |3,

1] R §i0: O B1:06n 120 L:00 200 300 400

Wednesday, July 26, 2006, : ‘

(=1 @ MWarren, Bon (DIT] ;
(=4 @ Niwsaii, Ererds I

£

Add Others 'r| Options W Mesting stast time! |WH?|I2|5,§E'|I|:'. l!il.:‘.'lIIFT"I s

5< | AutoPickNest >3 Maeting end tme: | Wed 7/26/2006 x| fzom =

B Busy B Tentative W Outof Office [ Mo Information




Canceling a Meeting

Open the appointment with Double Click,

Select Actions>Cancel Meeting.

Microsoft Outiook

.

E3

The attendees have not been notified that
this meeting "Monthly Meeting - Elsie/Lori"
has been canceled. Choose one of the

following:

« Send cancellation and delete meeting.

 Delete without sending a cancellation.

Ok

Cancel




Calendar Properties

General ] Home Page ] AutoArchive ]
Administration ] Forms Permissions l Synchronization ]
Mame: Permission Level:
M akl N Default Mone
g Pafford, Jamie (DLEG) Reviewsr
Strevel, Christina (DLEG) Reviewsr

Your Anonymous MNone
Calendar
Accessible pdéo | _Remore | |

Permissions
to Others permisson Level: | -

|  Create items | Folder owner

|  Readitems [

|  Create subfolders | Folder visible

Edit items Delete items

o Mone {+ Mone
£ Own (" Qwn
¢ Al O All

QK Cancel Help




Calendar Reminders

F T IRt

| Preferences | Mai Setup | Mail Format | Speling | Security  Other |Delegates |

Tools>
Options>
Other>
General —

Advance
Options>

Reminder
Options>

Display

Calendar.

General

Autodrchive

-ty Manages
FJ archive 1

Preview pane

=] Use thes
|= preview

Instant Messaging

& [v Enab
.
=
ks
Wedne
23

[2]%]

[ Empty the Deleted Ttems folder upon exiting
v Make Cutlook the default program for E-mail, Contacts, and

Advanced Options...

Tasks

|

General settings
Startup in this folder:

= r @ Record MWLE webinar on 4

Sl record MWLE webinar on 4

Outlook Today

v ‘Warn before permanently deleting items

r

[ Provide feedback with sound
v Show Paste Options buttons
| Enable mail logging {troubleshooting)

Appearance options

Date Navigator:
v WWhen viewing Motes
Task working hours per

Task working hours per

Reminder Cptions. .. |

Custom Forms... |

Font...

=

2 pt. Tahoma

Reminder Options

When a reminder comes due
¥ Display the reminder

Iv Play reminder sound:

|reminder.‘.'-.-a'-.-'

Ok |

Cancel |




Any Questions? Type them In
chat please!!



Using the Out of Office Assistant

Inbox folder>tools>out of office Assistant

DUt of Office Assistant

{+ I am currently In the Office

Zfﬂ I am currently Qut of the Office

AutoReply only once to each sender with the following text:

I'm gone till next Friday December 31, 2007,

Out Of Office Turned On

Cwk of Office is currently on, Would wou fike ko buen ik off?

Yes Mo |

Add Rule... ' v Show rules for all profiles

(04 Cancel

Help




Accessing Outlook Via the Internet

https://owae2k.state.mi.us/exchange

If you cannot get into the State server, you can
still access Outlook through this link.

Connect to owaelk.state.mi.us @

| ‘:‘

owaeZk.state.mi.us

User name: | 7 hubskyd v:
Password: | ETTTTTTTIIIIIT

Remember my password

| K, | | Cancel



https://owae2k.state.mi.us/exchange

| Microsoft OQutlook Web Access - Microsoft Internet Explorer

File Edit View Favorites Tools Help
b A, (= . . = ! |
@Back - Q @ @ A - Search ¢ Favorites @ (- 52 _J ﬂ ﬁ
Address |@ htips:/jowae2k. state. mi.us/exchange/ 1""'| Go Links @ Snaglt @ =
£i" Outlook WebAccess ™ Inbox (Messages ~) Items to130f13 [l € [ M
&) Help (] Log Of

drodes _ © 1o -

0 @

& {5 Hubsky, Darlene (DLEG) Al ¢ | (3|8 | From subject Received # Size | ¥
3 Ea:j'nzt =4 W Bilig, Joseph Fuwd: NVLB Orient - WFT 2008-04-29.ppt Wed 4/23/2008 11:31 AM SSIKB 7 A
alendar =
% Checkiist = Gamin, Patty (DLEG) RE: email to all of BWT Fri 4/18/2008 4:23 PM 110KE %
3 Comman Messures /& il King, Cynthia (DLEG) Fw': email to all of BWT Fri 4/18/2008 2:20 PM 124K ¥
g Contacts = Wl Strevel, Christina Invitations Oulook Fri 4/11,/2008 2:56 PM B3IKE 7
(5] Deleted Items (2) B W LEWIS, JOHNNIE Webinar Announcement - Group Wise Conversion to Ou... Fri 4/11/2008 1:156 PM 53KB %
] Documents i @ Kryza, Richard Selfridge and Lansing TAPS Tue 4/3/2005 10:21 AM 117KE ¥
07| Drafts i @ Hubsky, Darlene (DLEG) outlook files Tue 4/3/2008 5:43 AM IMB W
83 Field Services Group =i W Crow, Loretta Letterhead, Memo, & Fax Templates w/Mew Bureau Name Tue 4/3/2008 7:55 AM 247KV
£ F_T’:l Inbox | = W Morado, Trene Bureau of Waorkforce Transformation Information Mon 472008 2:23 PM ZBKE Y
J .
& JD”L”; '| 1 0 Strevel, Christina M/ 1 Migration Transcripts Mon 3/31/2008 2:31 PM B9KB
unk E-mai
E Junk E-mail 1 il strevel, Christina MiRSA Hospitality Promising Practices Webinar Fri 3/28/2008 10:53 AM 54KB W
i 7 : .
£ leadership academy i WKryza, Richard TAPS Thu 3/27/2008 2:01 M 93KB 7

[Cg managment institute -

o | Notes Fwd: NWLE Orient - WFT 2008-04-29.ppt

(= Outbox Billig, Joseph

[F= Sent Items o |_f'\l.ﬁ.ttachments can contain viruses that may harm your computer, Attachments may not display correctly.
<5 l 2 To: Pafford, Jamie; Hubsky, Darlene (DLEG)
@ Co

Attachments: | 1ey7 himsass) L nuile Orient - WET 2008-04-23.00t(55 1KE)

jﬁ Calendar
%=| Contacts
= Per Chris's request. Thanks for looking at this.
ﬁ Tasks -
e
1 Public Folders Toe
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Web Resources

e Go to Help Button while in Outlook and
select Office on the Web

* In the Search box type in Office 2002

o Select Outlook 2002 Help and How-to or
Outlook 2002 Support Center




Internal Resources

For additional assistance after you have
been Migrated to Michigan 1, please
contact:

« Joe Billig, billigj@michigan.gov,
517-241-8614

 Brian Waters, watersb@michigan.gov,
517-373-3625
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Any Questions? Type them In
chat please!!
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